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Abstract 

This paper provides step-by-step information, guiding you through the major scenarios for using 

the Microsoft® Application Compatibility Toolkit (ACT) 5.6. 

This information applies for the following operating systems: 

 Windows® 7 

 Windows Vista® 

 Windows Server 2008 R2 

 Windows Server 2003 

 Windows XP with Service Pack 2 

 Microsoft Windows 2000 
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Microsoft ACT: Step-by-Step Guide 

Overview 
The purpose of this white paper is to provide clear information about the core usage scenarios for 

Microsoft® Application Compatibility Toolkit (ACT) 5.6. While following the walkthroughs 

presented in this guide, you will create an inventory of currently installed applications, determine 

which applications might have compatibility issues, organize the data so that they make sense, 

and create the solutions to enable the problematic applications to run. 

Prerequisites for Walkthroughs 

To complete the walkthroughs described in this white paper, you must ensure that you: 

 Are an Administrator on the computer. 

 Have Internet access. 

 Have an environment of client computers to which you can deploy the data-collection 

packages (DCPs), including providing the required configuration, permissions, and database 

roles for each user account. 

For specific configuration and permission information, see the "Microsoft® ACT: 

Configuration and Troubleshooting" white paper or view the "Supported Software and 

Hardware" topic in the ACT Help. 

 Install any application, including Internet Explorer® 7 or Internet Explorer 8 (if you are using 

the Internet Explorer Compatibility Test Tool [IECTT]), for which you require compatibility 

data. 

 Install and configure the ACT 5.6 based on the information in the "Microsoft ACT: 

Configuration and Troubleshooting" white paper. 

 Plan your deployment strategy, including where and how to deploy the DCPs. 

ACT Walkthrough Exercises 
The following sections provide step-by-step instructions to walk you through each of the major 

ACT scenarios, which include deploying a new operating system or a service pack, applying a 

Windows® security update, and mitigating compatibility issues by using compatibility fixes. 

Deploying a New Operating System 

This walkthrough topic describes a scenario of an organization that is planning to deploy a new 

operating system into its environment, but first requires a more detailed assessment of the 

Note  
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potential compatibility issues. For this walkthrough, you must deploy the associated DCP to at 

least one of your client computers that is running one of the following operating systems: 

 Windows 7 

 Windows Vista® with Service Pack 1 or Service Pack 2  

 Windows XP with Service Pack 2 or Service Pack 3  

 Windows Server 2008 R2 

 Windows Server 2003 with Service Pack 1 or Service Pack 2 

 Microsoft Windows 2000 Server with Service Pack 4 and Update Rollup 1 

Phase 1: Collecting Your Inventory and Compatibility Data 

In this phase, you will create a new DCP that will collect your organization's inventory, which 

includes information about your computers, devices, installed applications, and associated 

compatibility issues. 

1. On the taskbar, click Start, point to All Programs, point to Microsoft Application 

Compatibility Toolkit 5.6, and then click Application Compatibility Manager. 

2. On the Collect screen, click File from the toolbar, and then click New. 

The New <DCP_Name> dialog box appears. 

3. In the Package Name box, type Inventory_Collection. 

4. In the Evaluate compatibility when area, click Deploying a new Operating System or 

Service Pack. 

5. Click Advanced. 

The Advanced Settings dialog box appears. 

6. Clear the User Account Control Compatibility Evaluator and Windows Compatibility 

Evaluators check boxes, and then click OK. 

The Advanced Setting dialog box closes. 

7. In the When to monitor application usage area, do not change the default options, but 

change the Duration to 10 Minutes. 

8. In the Output Location box, do not change the default value, previously specified in the 

ACT Configuration Wizard. 

9. On the File menu, click Save and Create Data Collection Package. 

10. Save the compiled DCP to your desktop. 

11. Determine which method you will use to deploy your DCP. For information about the 

various deployment options, see the "Deploying a Data Collection Package" topic in the 

ACT Help. 

12. By using the method determined in the previous step, deploy the DCP to your specified 

client computers’ desktops. 

To collect your software and hardware inventory  
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Note  

We recommend that you collect your data from approximately 10,000 computers, 

if you have a large number of available client computers in your organization. 

13. Double-click the packaged DCP from each identified client computer's desktop. 

The DCP runs on the client computer. 

1. Click Analyze from the left-hand navigation pane of your client computers. 

The Analyze screen appears. 

2. Click Send and Receive. 

The Send and Receive Data dialog box appears. 

3. Click Review the data before sending. 

The dialog box changes to show the applications that will send and will receive 

information from Microsoft during the synchronization process. 

Note  

You can disable specific applications from the synchronization process, so that 

you do not share the related issue data with Microsoft or the ACT Community. 

For more information, see the "Selecting Your Send and Receive Status" topic in 

the ACT Help. 

4. Click Send. 

Data synchronization occurs between your computer and the Microsoft Compatibility 

Exchange. 

5. Return to the Analyze screen and review the updated issue data for your applications. 

1. On the Collect screen, click File from the toolbar, and then click New. 

The New <DCP_Name> dialog box appears. 

2. In the Package Name box, type OS_Deployment. 

3. In the Evaluate compatibility when area, click Deploying a new Operating System or 

Service Pack. 

4. In the Where to output collected data area, in the Output Location box, do not change 

the default values. 

5. On the File menu, click Save and Create Data Collection Package. 

6. Save the compiled DCP to your desktop. 

7. As you did previously, deploy your DCP and synchronize your data. 

To view and synchronize your data 

To collect your application compatibility data 
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Phase 2: Analyzing Your Compatibility Data 

In this phase, you will organize your data by using priorities, assessment ratings and categories 

and subcategories. After organizing your data, you will be able to filter your compatibility data, 

determine which applications might have compatibility issues, and view the information in 

customized reports. 

Prioritizing Your Data 

In this section, you will prioritize your application compatibility data, based on the importance of 

the application to your organization. For more information, see the "Prioritizing Your Data" topic in 

the ACT Help. 

The available priority levels are: 

 Priority 1 - Business Critical. The highest priority level. Business-critical items are so 

important to your organization that, unless you certify them, you will not deploy the updated 

operating system. 

 Priority 2 - Important. The priority level for applications, Web sites, computers, devices, and 

updates that your organization regularly uses but can continue to function without. You can 

choose to deploy the updated operating system without requiring certification. 

 Priority 3 - Nice to Have. The priority level for applications, Web sites, computers, devices, 

and updates that do not fall into the previous two categories but that you to want to appear in 

your ACT compatibility reports. You will deploy the updated operating system regardless of 

certification. 

 Priority 4 - Unimportant. The priority level for applications, Web sites, computers, devices, 

and updates that are irrelevant to your organization's daily functions. You can use this priority 

level to filter out the unimportant items from your reports. 

 Unspecified. The default priority level, which is automatically assigned to all applications, 

Web sites, computers, devices, and updates. Your organization can use this priority level to 

denote applications that have not yet been reviewed for deployment. 

1. On the Analyze screen, click Applications from the Windows 7 Reports heading in the 

Quick Reports pane. 

The Windows 7 – Application Report screen appears. 

2. Click Microsoft Application Compatibility Toolkit 5.6, and then on the Actions menu, 

click Set Priority. 

The Set Priority dialog box appears. 

3. Click Priority 1 – Business Critical, and then click OK. 

Categorizing Your Data 

In this section, you will create categories and subcategories and assign them to an application. 

For more information, see the "Categorizing Your Data" topic in the ACT Help. 

To prioritize your applications 
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1. In the Windows 7 - Application Report screen, click Microsoft Application 

Compatibility Toolkit 5.6. 

2. On the Actions menu, click Assign Categories. 

The Assign Categories dialog box appears. 

3. Click Category List. 

The Category List dialog box appears. 

4. In the Categories area, click Add, type Location, and then press ENTER. 

5. In the Subcategories area, click Add, type United States, and then press ENTER. 

6. In the Subcategories area, click Add, type Europe, and then press ENTER. 

7. Click OK to close the Category List dialog box. 

8. Click OK to close the Assign Categories dialog box. 

1. In the Windows 7 - Application Report screen, click Microsoft Application 

Compatibility Toolkit 5.6. 

2. On the Actions menu, click Assign Categories. 

The Assign Categories dialog box appears. 

3. Select the United States check box, and then click OK. 

The Assign Categories dialog box closes. 

Note  

Although United States is a subcategory, when you select the check box, it 

automatically selects the parent category. If you assign a category, you must 

assign one or more subcategories. 

Selecting Your Assessment Rating 

In this section, you will select your organization's assessment rating for an application, based on 

the 32-bit and 64-bit versions of the operating system. Your assessment rating enables you to 

specify which applications might be problematic while going through your organization's testing 

process. 

Your application assessments originate from authoritative sources, such as Microsoft and the 

application vendor, your own testing, and the Application Compatibility Toolkit (ACT) Community, 

if you are a member. For more information, see the "Selecting Your Assessment Rating" topic in 

the ACT Help. 

The following table describes the icons that appear in the My Assessment and the Vendor 

Assessment columns on the Analyze screen. 
 

To create a new category and a new subcategory 

To assign a category and a subcategory 
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Icon Description 

 
 

Denotes applications that work properly on a 

32-bit operating system and function as 

expected. 

 
 

Denotes applications that work properly on a 

64-bit operating system and function as 

expected. 

 
 

Denotes applications with issues that are minor 

or have known solutions on 32-bit operating 

systems. 

 
 

Denotes applications with minor issues or 

known solutions on 64-bit operating systems. 

 
 

Denotes applications with major issues, such 

as data loss or severely impaired functionality 

on 32-bit operating systems. 

 
 

Denotes applications with major issues, such 

as data loss or severely impaired functionality, 

on 64-bit operating systems. 

 
 

Denotes applications that do not have any 

application-assessment data for 32-bit 

operating systems. In this case, either the 

application does not match any information in 

the database or no assessment has been 

submitted. 

 
 

Denotes applications that do not have any 

application-assessment data for 64-bit 

operating systems. In this case, either the 

application does not match any information in 

the database or no assessment has been 

submitted. 

 

1. In the Windows 7 - Application Report screen, click Microsoft Application 

Compatibility Toolkit 5.6. 

2. On the Actions menu, click Set Assessment. 

The Set Assessment dialog box appears. 

3. Click Works in both the 32-bit and 64-bit column, and then click OK. 

To select your assessment rating 
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ACT Community Assessments 

The ACT community can rate the compatibility of an application. Ratings are displayed 

graphically (changing from red to yellow to green) in the Community Assessment column. To 

understand what the rating color means, you must first understand how the underlying community 

rating works. There are three available scores, based on the rating for an application. 

 Works. If you vote that an application works, it is denoted as five green bars. 

 Works with minor issues or has solutions. If you vote that an application has minor 

issues, it is denoted as three light green bars. 

 Does not work. If you vote that an application does not work, it is denoted as a single red 

bar. 

The ACT then takes your information and combines it with all of the information provided by the 

other ACT Community users and averages the ratings to show a color gradient from one to five 

bars. 

 
 

Filtering Your Data 

In this section, you will create a single filter to display your compatibility data based on your 

priority, category, subcategory, and assessment rating. After filtering your data, you can view the 

results as a customized report that is tailored to your organizational requirements. For more 

information, see the "Filtering Your Compatibility Data" topic in the ACT Help. 

1. In the Windows 7 - Application Report screen, click Toggle Filter. 

2. In the Field list, click Priority. 

The Operator field will automatically update with the Equals option, and the Value box 

will automatically update with the Priority 1 – Business Critical option. 

3. Press the TAB key to create a new query row. 

4. In the And/Or list, click And. 

5. In the Field list, click 32-bit Internal Assessment. 

6. In the Value list, click Works. 

7. Press the TAB key to create a new query row. 

8. In the And/Or list, click And. 

9. In the Field list, click Categories (+). 

The remaining filter criteria is completed and a linked row is automatically created. 

10. In the linked row Field list, click Category Name. 

The Operator field will automatically update with the Equals option and another linked 

To create a customized filter 
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row is created. 

11. In the Value box, select Location. 

12. In the linked row And/Or list, click And. 

13. In the Field list, click Subcategory Name. 

The Operator field will automatically update with the Equals option. 

14. In the Value box, select United States. 

15. Right-click anywhere in the row, and then click Execute. 

The filter sorts your data to display the Microsoft Application Compatibility Toolkit 5.6 

because it is the only application that fulfills all the filter criteria. 

Viewing a Report 

In this section, you will view the <Operating_System> Application Report screen and an 

associated <Application_Name> dialog box. The <Operating_System> Application Report 

screen enables you to view your data by individual operating system, such as Windows 7. The 

application details dialog box enables you to view more deeply detailed data, such as the 

assessment rating, known issues and solutions, application properties, or computer details. 

1. On the Analyze screen, click Applications from the Windows 7 Reports heading in the 

Quick Reports pane. 

The Windows 7 – Application Report screen appears. 

2. Double-click Microsoft Application Compatibility Toolkit 5.6. 

The Microsoft Application Compatibility Toolkit 5.6 dialog box appears, showing the 

Assessment tab. 

3. Click the Issues, Application Properties, Computers, and Tags tabs for more 

information about the application as it relates to that heading. 

Adding and Resolving Issues and Solutions 

In this section, you will add a new compatibility issue and a new solution, and then you will 

resolve the issue for your organization. For more information, see the "Creating and Editing 

Issues and Solutions" topic in the ACT Help. 

1. In the Microsoft Application Compatibility Toolkit 5.6 dialog box, click Add Issue. 

The Microsoft Application Compatibility Toolkit 5.6 – New Issue dialog box appears. 

2. In the Title box, type Example_Issue. 

3. In the Priority list, click Priority 3 – Nice to Fix. 

4. In the Severity list, click Severity 3 – Minor functionality loss. 

To view an application's details 

To add and to resolve a compatibility issue 
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5. In the Symptom list, click Application has impaired functionality. 

6. In the Cause list, click Application requires a deprecated component. 

7. In the Affected Operating Systems box, do not change the selected default value 

(Windows 7). 

8. In the Issue Description box, type This is the issue description text. 

9. On the File menu, click Save. 

10. On the Actions menu in the Microsoft Application Compatibility Toolkit 5.6 – 

Example_Issue dialog box, click Add Solution. 

The Microsoft Application Compatibility Toolkit 5.6 – Add Solution dialog box 

appears. 

11. In the Title box, type Example_Solution. 

12. In the Solution Type box, click Application configuration change. 

13. In the Solution Details box, type This is the solution details text. 

14. Click Save. 

15. On the Actions menu in the Microsoft Application Compatibility Toolkit 5.6 – 

Example_Issue dialog box, click Resolve. 

The issue is resolved. The Resolved icon appears in the Status column for the issue, on 

the Issues tab. 

Phase 3: Testing and Fixing Your Issues 

After you have collected and analyzed your data, you must test and mitigate (fix) your issues. 

This process can be accomplished by using the Standard User Analyzer (SUA) and the 

Compatibility Administrator, which are provided with the ACT and are located in the Developer 

and Tester Tools folder. For specific walkthrough instructions, see the "Phase 3: Mitigating Your 

Issues by Using Compatibility Fixes" section later in this white paper. For more detailed 

information about each tool, including information that is not included in this white paper, see the 

associated topics in the ACT Help. 

Applying a Windows Update 

This walkthrough describes a scenario of an organization that is planning to deploy a Windows® 

update into its environment, but first requires a more detailed assessment of the potential 

compatibility issues. For these exercises, you must deploy the associated DCP to at least one of 

your client computers that is running one of the following operating systems: 

 Windows 7 

 Windows Vista with Service Pack 1 (SP1) or Service Pack 2 (SP2) 

 Windows XP with Service Pack 2 (SP2) or Service Pack 3 (SP3) 

 Windows Server 2008 R2 

 Windows Server 2003 with Service Pack 1 (SP1) or Service Pack 2 (SP2) 
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 Microsoft Windows 2000 with Service Pack 4 (SP4) and Update Rollup 1 

Phase 1: Collecting Your Inventory and Compatibility Data 

In this phase, you will create a new DCP that will collect your organization's inventory, which 

includes information about your computers, devices, installed applications, and associated 

compatibility issues. 

1. On the taskbar, click Start, point to All Programs, point to Microsoft Application 

Compatibility Toolkit 5.6, and then click Application Compatibility Manager. 

2. On the Collect screen, click File from the toolbar, and then click New. 

The New <DCP_Name> dialog box appears. 

3. In the Package Name box, type Inventory_Collection. 

4. In the Evaluate compatibility when area, click Applying Windows Updates. 

5. Click Advanced. 

The Advanced Settings dialog box appears. 

6. Clear the Update Compatibility Evaluator check box, and then click OK. 

The Advanced Setting dialog box closes. 

7. In the When to monitor application usage area, do not change the default options, but 

change the Duration to 10 Minutes. 

8. In the Output Location box, do not change the default value, previously specified in the 

ACT Configuration Wizard. 

9. On the File menu, click Save and Create Data Collection Package. 

10. Save the compiled DCP to your desktop. 

11. Determine which method you will use to deploy your DCP. For information about the 

various deployment options, see the "Deploying a Data Collection Package" topic in the 

ACT Help. 

12. By using the method determined in the previous step, deploy the DCP to your specified 

client computers’ desktops. 

Important  

We recommend that you collect your data from approximately 10,000 computers 

if you have a large number of available client computers in your organization. 

13. Double-click the packaged DCP from each identified client computer's desktop. 

The DCP runs on the client computer. 

1. On the left-hand navigation pane of your client computer, click Analyze. 

To collect your software and hardware inventory  

To view and synchronize your data 
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The Analyze screen appears. 

2. Click Send and Receive. 

The Send and Receive Data dialog box appears. 

3. Click Review the data before sending. 

The dialog box changes to show the applications that will send and will receive 

information from Microsoft during the synchronization process. 

Note  

You can disable specific applications from the synchronization process so that 

you do not share the related issue data with Microsoft or your assessment ratings 

with the ACT Community. For more information, see the “Selecting Your Send 

and Receive Status” topic in the ACT Help. 

4. Click Send. 

Data synchronization occurs between your computer and the Microsoft Compatibility 

Exchange. 

5. Return to the Analyze screen and review the updated issue data for your applications. 

1. On the Collect screen, click File from the toolbar, and then click New. 

The New <DCP_Name> dialog box appears. 

2. In the Package Name box, type OS_Deployment. 

3. In the Evaluate compatibility when area, click Applying Windows Updates. 

4. In the Output Location box, do not change the default values, previously specified in the 

ACT Configuration Wizard. 

5. On the File menu, click Save and Create Data Collection Package. 

6. Save the compiled DCP to your desktop. 

7. As you did previously, deploy your DCP and synchronize your data. 

Phase 2: Analyzing Your Compatibility Data 

In this phase, you will organize your application data by using priorities, categories and 

subcategories, and you will organize your Windows updates by using severity ratings. After 

organizing your data, you will be able to filter your compatibility data, to determine which 

applications or Windows updates might have compatibility issues, and to view the information in 

customized reports. 

Prioritizing Your Data 

In this section, you will prioritize your application data, based on the importance of the application 

or update to your organization. For more information, see the "Prioritizing Your Data" topic in the 

ACT Help. 

To collect your application compatibility data 
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The available priority levels are: 

 Priority 1 - Business Critical. The highest priority level. Business-critical items are so 

important to your organization that, unless you certify them, you will not deploy the updated 

operating system. 

 Priority 2 - Important. The priority level for applications, Web sites, computers, devices, and 

updates that your organization regularly uses but can continue to function without. You can 

choose to deploy the updated operating system without requiring certification. 

 Priority 3 - Nice to Have. The priority level for applications, Web sites, computers, devices, 

and updates that do not fall into the previous two categories but that you want to appear in 

your ACT compatibility reports. You will deploy the updated operating system regardless of 

certification. 

 Priority 4 - Unimportant. The priority level for applications, Web sites, computers, devices, 

and updates that are basically irrelevant to your organization's daily functions. You can use 

this priority level to filter out the unimportant items from your reports. 

 Unspecified. The default priority level, which is automatically assigned to all applications, 

Web sites, computers, devices, and updates. You can use this priority level to denote 

applications that have not yet been reviewed for deployment. 

1. On the Analyze screen, click Applications from the Update Impact Reports heading in 

the Quick Reports pane. 

The Update Impact Reports – Applications screen appears. 

2. Click Microsoft Application Compatibility Toolkit Data Collector 5.6, and then click 

the Set Priority button. 

The Set Priority dialog box appears. 

3. Click Priority 2 – Important, and then click OK. 

Categorizing Your Data 

In this section, you will create categories and subcategories and assign them to an application. 

For more information, see the "Categorizing Your Data" topic in the ACT Help. 

1. In the Update Impact Reports - Applications screen, click Microsoft Application 

Compatibility Toolkit Data Collector 5.6. 

2. On the Actions menu, click Assign Categories. 

The Assign Categories dialog box appears. 

3. Click Category List. 

The Category List dialog box appears. 

4. In the Categories area, click Add, type Department, and then press ENTER. 

To prioritize your applications 

To create a new category and a new subcategory 
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5. In the Subcategories area, click Add, type Sales, and then press ENTER. 

6. In the Subcategories area, click Add, type Marketing, and then press ENTER. 

7. Click OK to close the Category List dialog box. 

8. Click OK to close the Assign Categories dialog box. 

1. In the Update Impact Reports - Applications screen, click Microsoft Application 

Compatibility Toolkit Data Collector 5.6. 

2. On the Actions menu, click Assign Categories. 

The Assign Categories dialog box appears. 

3. Select the Sales check box, and then click OK. 

The Assign Categories dialog box closes. 

Note  

Although Sales is a subcategory, when you select the check box, it automatically 

selects the parent category. If you assign a category, you must assign one or 

more subcategories. 

Selecting Your Severity 

In this section, you will select your organization's severity rating for the Windows update. You can 

use the severity rating to specify which updates might be problematic, and how severe that 

problem might be for your organization. For more information, see the "Selecting Your Severity 

Assessment" topic in the ACT Help. 

1. On the Analyze screen, click Updates from the Update Impact Reports heading in the 

Quick Reports pane. 

The Updates screen appears. 

2. On the Actions menu, click Set Severity. 

The Set Severity dialog box appears. 

3. Click Severity List. 

The Severity List dialog box appears. 

4. Click Add, type Unimportant, and then press the ENTER key. 

5. Click OK to close the Severity List dialog box. 

6. Click OK to close the Set Severity dialog box. 

1. On the Updates screen, click the Windows update that is listed first in the right pane, and 

To assign a category and a subcategory 

To create a new severity rating 

To select a severity rating 
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then click the Set Severity button. 

The Set Severity dialog box appears. 

2. Click Unimportant, and then click OK. 

Filtering Your Data 

In this section, you will create a single filter to display your compatibility data based on your 

priority, category, and subcategory selections. After filtering your data, you can view the results 

as a customized report tailored to your organizational requirements. For more information, see 

the "Filtering Your Compatibility Data" topic in the ACT Help. 

1. On the Analyze screen, click Applications from the Update Impact Reports heading in 

the Quick Reports pane. 

The Update Impact Reports – Applications screen appears. 

2. In the Update Impact Reports – Applications screen, click Toggle Filter. 

3. In the Field list, click Priority. 

The Operator field will automatically update with the Equals option. 

4. In the Value box, select Priority 2 - Important. 

5. Press the TAB key to create a new query row. 

6. In the And/Or list, click And. 

7. In the Field list, click Categories (+). 

The remaining filter criteria is completed and a linked row is automatically created. 

8. In the linked row Field list, click Category Name. 

The Operator field will automatically update with the Equals option and another linked 

row is created. 

9. In the Value box, select Department. 

10. In the linked row And/Or list, click And. 

11. In the Field list, click Subcategory Name. 

The Operator field will automatically update with the Equals option. 

12. In the Value box, select Sales. 

13. Right-click anywhere in the row, and then click Execute. 

The filter sorts your data to display the Microsoft Application Compatibility Toolkit 

Data Collector 5.6 because it is the only application that fulfills all the filter criteria. 

Viewing a Report 

In this section, you will view the Update Impact Reports - Applications report, the associated 

details dialog box, the Update Impact Report - Updates report, and its associated security 

update dialog box. 

To create a customized filter 
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1. On the Analyze screen, click Applications from the Update Impact Reports heading in 

the Quick Reports pane. 

The Update Impact Reports - Applications screen appears. 

2. Double-click Microsoft Application Compatibility Toolkit Data Collector 5.6. 

The Microsoft Application Compatibility Toolkit Data Collector 5.6 dialog box 

appears, displaying the compatibility details for the application. 

3. Click the Intersecting Updates, Application Properties, Computers, and the Labels 

tab for more information about the application as it relates to that heading. 

1. Click Updates from the Update Impact Reports heading in the Quick Reports pane. 

The Updates screen appears. 

2. Double-click the Windows update that is listed first in the right pane. 

A security update dialog box appears, displaying the details for the update. 

3. Click the Intersecting Applications, Update Properties, and Computers tab for more 

information about the update as it relates to that heading. 

Phase 3: Testing and Mitigating Issues by Using Compatibility Fixes 

After you have collected and analyzed issues in the Application Compatibility Manager, use the  

Standard User Analyzer (SUA) and the Compatibility Administrator to test and mitigate issues. 

These tools are provided with the ACT and are located in the Developer and Tester Tools folder. 

For specific walkthrough instructions and environment configuration information, see the 

“Microsoft ACT: Phase3 - Mitigating Issues by Using Compatibility Fixes” white paper, available 

for download from the Related Resources section of the Microsoft Application Compatibility 

Toolkit 5.6 Download Web page. For more detailed information about each tool, including 

information that is not included in this white paper, see the associated topics in the ACT Help. 

Testing and Mitigating User Account Control-Related Issues with 
the Standard User Analyzer and the Compatibility Administrator 

This walkthrough describes the scenario of an organization that wants to use the Standard User 

Analyzer (SUA) to test its applications to detect potential compatibility issues related to User 

Account Control (UAC) and then use the compatibility fixes available in the Compatibility 

Administrator to fix the known issues. UAC, formerly known as Limited User Account (LUA), 

requires that all users (including members of the Administrator group) run as Standard Users until 

the application is deliberately elevated by using the security prompt dialog box. However, 

applications that require access and privileges for locations that are not available to a Standard 

User cannot run properly with the Standard User role. 

To view an Update Impact Reports – Applications report 

To view the Update Impact Reports - Updates reports 

http://go.microsoft.com/fwlink/?LinkID=82101
http://go.microsoft.com/fwlink/?LinkID=82101
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This walkthrough uses the SUA tool because it provides additional functionality. 

However, you can also use the SUA Wizard, which is in the same location as the SUA 

tool. The wizard also evaluates the issues. However, it does not offer any of the detailed 

analysis of the SUA tool, and you cannot use the wizard to disable virtualization or to 

elevate your privileges. 

Collecting the UAC-related issues 

First, use the SUA tool to test an application and to locate the UAC-related issues. 

1. Click Start, point to All Programs, point to Microsoft Application Compatibility Toolkit 

5.6, point to Developer and Tester Tools, and then click Standard User Analyzer. 

The SUA tool starts. 

2. In the Target Application field, browse to the \Program Files\Microsoft Application 

Compatibility Toolkit\Compatibility Administrator (32-bit)\Demo 

Application\StockViewer directory, and then double-click StockViewer.exe. 

3. Clear the Elevate check box, and then click Launch. 

The StockViewer tool attempts to start and the Permission denied dialog box appears. 

4. Click OK. 

The StockViewer application starts, despite the warning. 

5. On the toolbar, click the Trends button. 

An error message appears, stating that the application cannot create the object. 

6. Click OK to close the error message. 

7. On the Tools menu, click Options. 

An error message appears, stating that there was an unhandled exception in the 

application. 

8. Click Continue to close the error message and to continue testing the application. 

9. On the Help menu, click Check for Updates. 

Another error message appears, stating that there was an unhandled exception in the 

application. 

10. Click Continue to close the error message and to continue testing the application. 

11. Close the StockViewer application. 

SUA automatically collects and shows the data that was found during the application run 

time. 

Note  

To collect UAC-related issues by using SUA 
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Reviewing the SUA Tool Results 

After collecting UAC-related issues from the StockViewer tool, review the information in the SUA 

tool. 

1. In the SUA tool, click the Registry tab to review the registry issues. 

2. Click the Token tab to review the issue that occurred when checking the token. 

3. Click the Name Space tab to review the issues that occurred with the global name space. 

4. Click the Other Objects tab to review the UAC-related mapping issue that occurred. 

5. Click the Process tab to review the issues that occurred while launching a process. 

Applying the Recommended Mitigations 

After reviewing the UAC-related information from the various tabs of the SUA tool, you can review 

and apply the recommended mitigations. 

1. In the SUA tool, on the Mitigation menu, click Apply Mitigations.  

The Mitigate AppCompat Issues dialog box appears. 

2. Review the recommended compatibility fixes. For more detailed information about each 

compatibility fix, see Windows Vista and Newer Operating Systems or the Windows 

XP and Earlier topics. 

3. Click Apply. 

The SUA tool generates a custom compatibility fix database and automatically applies it 

to your local computer, so that you can test the fixes to see if they worked. 

Testing the Mitigations 

After the SUA tool applies the custom compatibility fix database to your computer, you must test 

the StockViewer application to see if all of your issues are fixed. 

1. Browse to the \Program Files\Microsoft Application Compatibility 

Toolkit\Compatibility Administrator (32-bit)\Demo Application\StockViewer 

directory, and then double-click StockViewer.exe 

The StockViewer application starts without causing the Permission denied dialog box to 

appear. 

2. On the toolbar, click the Trends button. 

The Trends screen appears. 

To review the SUA tool results 

To review and apply the recommended mitigations 

To test the recommended mitigations 
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3. On the Tools menu, click Options. 

The Options page appears. 

4. On the Help menu, click Check for Updates. 

The StockViewer tool successfully checks for updates. 

Creating a Custom Compatibility Fix Database for Deployment 

Now that you know the recommended compatibility fixes work, you can create your own custom 

compatibility fix database to deploy across your organization. 

1. Click Start, point to All Programs, point to Microsoft Application Compatibility Toolkit 

5.6, point to Developer and Tester Tools, and then click Compatibility Administrator. 

The Compatibility Administrator appears. 

2. Select the New Database (1) [Untitled_1] custom database. 

3. On the toolbar, click the Fix button. 

The Create New Application Fix wizard appears, showing the Program information 

page. 

4. In the Name of the program to be fixed field, type StockViewer. 

5. In the Name of the vendor for this program field, type Contoso. 

6. In the Program file location field, type C:\Program Files\Microsoft Application 

Compatibility Toolkit\Compatibility Administrator (32-bit)\Demo 

Application\StockViewer\StockViewer.exe, and then click Next. 

The Create new Application Fix wizard shows the available Compatibility Modes. 

7. Leave the fields blank, and then click Next. 

The Create new Application Fix wizard shows the available Compatibility Fixes. 

8. Check the boxes for the ForceAdminAccess, LocalMappedObject, 

VirtualizeHKCRLite, and ElevateCreateProcess compatibility fixes, and then click 

Next. 

The Create new Application Fix wizard shows the available matching information. 

9. Accept the default matching information, and then click Finish. 

The custom database is created in the Custom Databases node. 

10. Select the new custom database. 

11. On the toolbar, click Save 

12. In the File Name field, type Contoso and then save the file, contoso.sdb, to your 

desktop. 

To create a custom compatibility database 
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Removing the SUA Mitigations Database 

Before you deploy your custom compatibility fix database, remove the original database created 

by the SUA tool and then install and test the Contoso.sdb database again to ensure that the 

compatibility fixes were successfully applied to your local computer. 

 In the Compatibility Administrator, expand the Installed Databases node, right-click the 

SUA Mitigations database (the only installed database that includes the StockViewer 

application), and then click Uninstall. 

The SUA Mitigations database uninstalls from your local computer. 

1. In the Custom Databases node, right-click the Contoso.sdb database, and then click 

Install. 

2. Verify that the Contoso database appears in the Installed Databases node. 

3. Repeat the steps listed in the Testing the Mitigations section of this topic to ensure that 

the fixes have been successfully applied to the computer. 

Deploying the Contoso.sdb Database to Your Environment 

Finally, you can deploy the Contoso.sdb database into your environment so that the StockViewer 

application functions properly on all of your computers. For the purpose of this exercise, we 

simulate placing the Contoso.sdb database on a network share, and then we create a script to 

enable a management tool, such as Microsoft System Center Configuration Manager, to install 

the database for later deployment to your environment. 

1. Create a new folder on your desktop, named SDBShare. 

2. Right-click the SDBShare folder, and then click Properties. 

The Properties dialog box appears. 

3. Click the Sharing tab, and then click Advanced Sharing. 

4. Select the Share this folder check box, accept the default values, and then click OK. 

5. Close the Properties dialog box. 

6. Drag the Contoso.sdb database file, previously created and stored on your desktop, into 

the SDBShare folder. 

The compatibility fix database is now available for installation by remote computers. 

1. To retrieve your computer name, open a Command Prompt window and type net config 

To remove the SUA Mitigations database 

To install the custom database 

To create the network share location 

To create the deployment script 
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workstation. 

2. Click Start, point to All Programs, click Accessories, and then click Notepad. 

The Notepad tool appears. 

3. Type sdbinst “\\<your_computer_name>\SDBShare\Contoso.sdb” –q, and then save 

the file to your desktop as SDBInstScript.cmd. 

4. Click Start, point to All Programs, click Accessories, right-click Command Prompt, 

and then click Run as Administrator. 

A Command Prompt window appears with Administrator permissions. 

5. Type C:\users\<your_profile_name>\desktop\sdbinstscript.cmd, and then press 

ENTER. 

The Contoso.sdb database file is installed to the local computer. Run this script on each 

computer in your environment to ensure that the applications run properly. 
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